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1. Introduction 

Mnova Gears is a software suite that can be used to build automation workflows for your analytical data 

analyses (NMR, MS, IR, etc.). It is built around the concept of plugins called “bricks” that execute specific tasks 

in a fully automatic mode from data pickup and processing to results reporting, saving, and databasing. In 

addition to full automation, Mnova Gears allows for the customization of every step in your workflow to adapt 

it to your specific needs. 

Mnova Gears comes in two flavors: 

• The Mnova Gears product, suitable for the processing large datasets in batches or in real time. 

• The Mnova MyGears product, that allows you to build and run workflows based on single samples. 

MyGears is best suited to small-scale analyses, where the overhead of manually opening data is not 

significant but the benefits of automating processing and reporting are hugely so. 

Several Mnova Gears bricks are currently available that can be used as standalone components or in 

combination in a workflow.  

Please check our website page for more details about available bricks and don´t hesitate to contact us to 

discuss your custom automations! 
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Apart from running automated workflows, Mnova Gears allows you to operate in a machine-to-machine 

mode* which means that you can run one or several workflows on your datasets with minimal human 

intervention. In this case, datafiles and workflow parameters must be provided by the user or an external 

program so that Mgears can operate on them. 

 

*Requires Machine-to-machine license   
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2. Installation  

Once you receive your software or plugin license, open Mnova and drag-and-drop your license file into the 

application. Then, go to the File tab > Advanced Plug-ins. A new window will open. In the Available tab, select 

the Mnova Gears plugin and click on Install. 

 

A window will open to prompt you to restart the application. Click on OK. 

 

Close Mnova and open it again.  
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Check that the plugin has been installed correctly. All installed plugins will be listed in the Installed tab (File > 
Advanced Plug-ins). 

 

If installation has been successful, you will find Mgears, Mgears Viewer, MyGears and MyGears Workflows in 

the Mnova ribbon under the Automation section.  
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Note. If the Automation tab is not visible in the Mnova Ribbon, go to Options>Customize…, and manually 

add Automation to the ribbon.   
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3. Mgears dialog 

The Mgears dialog has a simple and straightforward design that includes: 

- six tabs, each allowing the setup of a single part of the workflow  
- a set of commands to control analysis 

 

 

As represented by the dialog sections, a full Mgears workflow will start with the selection of the input data 

and then go to the rest of the processing, analysis, and reporting configuration. Alternatively, when using 

MyGears, the workflow starts a step further on, at the processing tab, since the user should already have the 

relevant data file opened in Mnova.  

 

 

In the following sections, we will detail each tab of the Mgears dialog and the many configuration options each 

tab offers.  
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3.1. Input 

Mgears can handle input data saved on Disk directories, in a database (DB), or acquired in Real Time from a 

disk or from a network drive. These three modes are visible on the left-hand side of the Mgears dialog.  

 

Each mode has a specific configuration that will allow you to adapt Mgears to your data and handle your 

analysis appropriately. 

3.1.1. Data from disk 

To analyze input data from your Disk, click on  and select the Main directory in which your data files are 

saved. If part of your input data is saved in another folder, you can additionally select and add that folder in 

the Optional directory. 
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3.1.1.1. Mask manager 

Click on this  button to open the Mask Manager where you can edit and add new masks for your 
experiment files to be automatically detected by Mgears. The following default masks are available: 

• NMR (FID): fid,ser,*.jdf 

• NMR (Spectrum): 1r, 2rr 

• LC/GC/MS: _FUNC001.DAT, MSD1.MS, analysis.baf, _FUNC001.IDX, *.cdf, *.sms, *.ch, *.lcd, *.mcds 

• Chromatography: *.cdf, *.asc 

• UV/IR/Raman/Fluorescence: *.jdx, *.spa, *.spc 

• Structures: *.mol, *.sdf 

If your data mask is not in the list above, type it in the corresponding box for the experiment type then click 
OK to save your changes. See example in the image below. 
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Note. When your dataset contains multiple files for the same experiment that are matched with the declared 
masks (for instance, “_FUNC001.DAT” and “_FUNC001.IDX”), Mgears will detect one occurrence and discard 
the other matches so that you don’t get the same experiment duplicated. 

 

If the data file or folder incorporates both the experiment name and the extension (e.g., files named "C923-
m3.raw" or a folder named "A8723.D"), Mgears is capable of identifying the extension and excluding it from 
the experiment name. This functionality is facilitated by the list of masks accessible in the expert settings 
section. You have the flexibility to modify the default list and include your specific extensions, as illustrated in 
the image below. 

 

To undo any changes you introduce, you can click on Back to Default and then on OK. 
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It is also possible to use a custom script to open any file with Mgears. To do so, you must enable the Custom 

Format option, type your data folder masks, and upload the script by clicking on . The script will be 
executed when a file matches one of the masks added.  

 

Top Tip! Whenever you select your input data you can use the Automatic inspection button  to preview 

the detected data in your directories that will be used by Mgears to execute the analysis. 

 

3.1.1.2. Advanced options 

Several advanced options are available to give you more flexibility at the time of selecting your input data: 

□ Master file: If datasets are saved at different locations on the disk, it is possible to use a Master file 

with the list of paths to the directories with spectra and molecule files. A master file can be a .txt or a 

.csv file with an absolute path on each row.  

  



Mnova Gears 2.5 | User Manual                                                                                                                      

P/N 236 R3          Page 13 of 75 

Tick the Master file option then click on  to add your master file.  

 
 

In the Master file options  dialog, you can configure a set of basic features to give some flexibility 

to the input. You can indicate which column contains the path and set the starting and end row to 

read the data in the master file.  

 
 

□ Main SDF File: If you have all the molecular structures saved in a single SDF file, you can unable this 

option to automatically match each molecule to the corresponding datafile analyzed in a batch. 

Matching is done using a tag that is added to each molecule (“mixture_id” in the example below). 

Enable the Main SDF File option and upload your SDF file, then type the Tag with ID to be used. 

 

Mgears detects and matches each structure with the corresponding datafile. 
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□ Allow more than one experiment of each type: Activate this option when you want Mgears to detect 

several experiments of the same type in a document. In the example below, two MS raw datafiles are 

detected in each group.  

 
 

□ Join folders with similar name: This option is used to join spectra with similar starting names within 

the same group. If enabled, Mgears will detect repetitions or small variations in the data folder names. 

For instance, if there is a group “ABC” and a new spectrum is found named “ABC_raw”, it will be 

included in the “ABC” group because the start of the new file’s name, “ABC”, matches the previous 

group name. 
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□ Experiment Selection Mode: Choose this option if you want to detect raw data files only (FID) or both 

raw and processed data files (FID/Spectrum). When the FID/Spectrum mode is enabled, it is possible 

to manually select which data files to use for each type of experiment, as seen below:  

 

□ Select data files dates: Activate this option to detect data files created or modified between two 

specific dates. You can choose to filter by file Creation or Modification date. 

 

□ Preview Subset Only: Activating this feature allows you to choose the number of files you want to 

visualize in the Automatic inspection dialog . This option is checked by default and uses 1000 as 

its default value. When unchecked, all detected files are visualized. 
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□ Regular Expression to Adapt match: Check this option if you need to group samples with only a part 

of the file name matching. The regular expression you type will be used to capture the common part 

of the string in the names of the files detected, which will then be grouped in a single experiment. 

 

 

Use the Automatic inspection button  to check how Mgears has grouped the detected data. 
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□ Use Custom function: Check this option and upload a custom script to replace the default grouping 

algorithm used by Mgears. This is particularly useful when your data files names are not easy to group 

(for instance, when the file name is an ID generated automatically by the instrument).  

You can contact our team for advice and support. 

 

A simple script of about ~20 lines long can allow Mgears to: 

• Find all the header files in the specified directory from settings 

• Read the “sample description” 

• Create a group for each unique sample ID 

• Add relevant samples to this ID 
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Use the Automatic inspection button  to check how Mgears has grouped the detected data. 

 

Watch out! When using a custom function, a Warning symbol  appears next to the Automatic inspection 

button with a tooltip indicating that a custom scripting function is active. 
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3.1.1.3. Filtering options 

A Filtering string or a Mapping file can be used to filter your input data from the disk. Please refer to section 

3.1.4.  

Watch out! Advanced filtering will be disabled (hidden) while working with a Master file. 

3.1.2. Data from database 

Input data can also be retrieved from one or more Mnova spectral Databases (DB). In this mode, a list of 

spectra can be retrieved via a number of search terms for database fields. 

In the DB section, click on  to add a DB. 

 

A dialog will appear. Enter the Server name, Port, User, and Password, then click on Connect. 
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Once you have connected successfully to the server, select the Database containing your input data and click 

on OK. 

 

The selected database will appear in the table as seen in the image below. Click again on  to add another 

database if needed, or on   to delete a previously added database. 

 

It is possible to Search for text in the database. Type the text in the dedicated box then click on Search Text. 

You can optionally select a specific Field in the database for your search. In this example, two databases are 

searched by Molecule name. You can disable the search in one of these two databases by unchecking the 

corresponding box. 
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The search results will appear in the table below with the Record number and Database in which they were 

saved. 

 

If your search results include many records, you can exclude the records you don’t want to use in your analysis 

by unticking the corresponding checkbox.  

 

You can also use these buttons, , , and , to Check all and Uncheck all, or Clear the results table, 

respectively. 

Enable the Substring Search option to perform a search using substrings. 

 

3.1.2.1. Filtering options 

A Mapping file can be used to filter input data from a DB. Please refer to section 3.1.4. 

Watch out! When using the DB mode, the filtering options override the manual selection of data files, and 
therefore Mgears will disable the list of records if the Filter mode is selected. 

3.1.3. Data acquired in real time 

Input data can also be analyzed as soon as it is acquired. With the Real time (RT) mode, Mgears will watch 
(Listener) a set of folders for incoming data and operate on it as it arrives (or optionally when all expected 
parts of a set are ready). The RT input mode can help improve productivity by taking care of all the routine 
analysis before the user even interacts with the data. 
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The settings for the listener can be selected under the Real Time tab. Click on  to add the folder paths you 

want Mgears to watch. It is also possible to use URLs from networks that are visible to the system. 

 

You can add one or more paths. These will appear in the table as seen below. You can Delete a path or Clear 

the whole table by clicking on  or , respectively. 

 

3.1.3.1. Options 

□ Process old files: If checked, all files already present in the directory will be processed. In this case you 

can choose to Ignore Files and Directories older than a certain time. 

 

 

□ Group by folder: Enable this option to group spectra with similar folder names into a unique Mnova 

results document. Two other options are configurable in this case: Wait for all the Selected 

experiments to process them together (otherwise experiment files are processed once available in 

the watched folder), and Allow more than one experiment of Each type. Also, in this case, Filtering 

options are made available. 
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□ Wait for Structure and Spectra: This option will prompt Mgears to wait for at least one structure and 

one spectrum before processing an experiment. 

 

□ Join Folders with similar name: This option is used to join spectra with similar starting names within 

the same group. If enabled, Mgears will detect repetitions or small variations in the data folder names. 

For instance, if there is a group “ABC” and a new spectrum is found named “ABC-1” or “ABC_raw”, it 

will be included in the “ABC” group, because the start of the new file name, “ABC”, matches the 

previous group name. Please refer to section 3.1.1.2. 

 

□ Real Time settings: By clicking on this button, a dialog will open to allow you to set the folder listener’s 

settings.  

 
 

Real-time acquisition can be performed in two modes: 

 

• The Real Time mode, in which the listener will rely on the operating system (OS) to determine 

when changes happen in the listened directories. Such changes in the file system are therefore 

immediately reported to the user. With this mode, the listened folders can also be periodically 

checked for modifications every X minutes (X is the time set in the Time Between Checks option). 

This is useful when working with network shared units because, depending on the configuration, 

the OS may not report the changes correctly/in time.  

 

• The Timer mode, in which the listener will check the directories every “X” minutes to detect 

changes (“X” is the time set in the Time Between Checks option). With this option, the listener 

will generally consume fewer system resources.  

Another configurable setting is the Listened folder Levels value, which corresponds to the directory 

tree level that the listener will reach to look for modified files. When set to zero (0), the listener will 

only look in the top directory. Note that your folders’ architecture and size may affect the 

performance.  

The Delay value corresponds to the number of seconds that the system will wait to check whether the 

modifications in a specific file have finished. 

Finally, you can check the Multithreading option if you want the listener try to use several threads 

when creating the file cache, which will increase the performance of the system; and the Fast Hash 

Mode if you want the listener to only use the modification date of the file when looking for changes. 
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3.1.3.2. Advanced options 

□ Experiment Selection Mode: Choose this option if you want to detect raw data files only (FID) or both 

raw and processed data files (FID/Spectrum). When the FID/Spectrum mode is enabled, it is possible 

to manually select which data files to detect for each type of experiment. 

 

□ Regular Expression to Adapt match: This option will allow you to group samples when only part of 

the file name matches. The regular expression you type will be used to capture the common part of 

the string in the names of the files detected and group them in a single experiment. Please refer to 

section 3.1.1.2. 

 

□ Allow Reprocessing Custom Format File: When working with custom format files, this option allows 

you to reprocess a custom file after making changes. If this option is disabled, Mgears will discard a 

previously processed file and won't reprocess it. 

 

□ Ignore Problem Opening spectra: Sometimes Mnova will return an error when opening a file even 

though the file has loaded correctly. By enabling this option, you can force Mgears to ignore problems 

detected by Mnova and use the file anyway, otherwise Mgears will not use the affected spectrum.  

 

 

3.1.3.3. Filtering options 

A Filtering string or a Mapping file can only be used when the Group by Folder option has been enabled. 

Please refer to section 3.1.4. 

3.1.4. Filtering options 

Filtering options are available for all three sources of input data (from Disk, DB, or Real Time), which allows 

you to refine your data detection and better adapt it to your data configuration. 

3.1.4.1. Filtering string 

The Filtering string can be used to filter the detected files from Disk or Real time acquisition using a string with 

common wildcards (* and ?) or a regular expression. 
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Type your filtering string in the corresponding box. The Automatic inspection button  is used to preview 

the detected data before and after filtering.  

 

You can check the Regular expression option to force the use of a regular expression over the normal filtering 

string. 

Check the option Filter by name only to only filter the name and not the full paths of the spectra. 

 

3.1.4.2. Mapping file 

Using a Mapping file is convenient when input files are listed in an .txt or .csv document along with other 

metadata. Mgears will map the information found in the file provided with the information found in the 

selected input directory (on Disk, DB, or RT folder). 
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Click on  to choose your mapping file from your directory. 

 

More filtering options are available when the input data is retrieved from Disk or through Real time acquisition. 

To configure these Advanced Filtering Options, click on . In the dialog that appears, indicate which column 
of the mapping file will be used to match information in your data directory. You can either type the column 

number or click and open the assistant   to visualize the .csv and select the desired column. In the assistant, 
only the first 10 rows of the filtering file will be loaded. 

 

Choose the Starting row you want to read your .csv from and, optionally, enter the last row you want to read.  

 

Enable the Allow Gaps in Results option if you want to include void results for the empty cells in the plate 
with the lines in the filtering files.  
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In addition to the mapping of data files, it is possible to read other metadata, such as: 

• sample Position in the well plate (only available when the Allow Gaps in Results option is enabled) 

• compound ID  

• compounds SMILES string. 

 

With this configuration, SMILES strings and well positions are read and recognized by Mgears, as you can see 

when using the Automatic inspection button . 

 

Substring Matching: If this option is checked, the clustering algorithm will include spectra with small 
differences at the ends of their names. For example, if the requested group is “ABC”, detected files “ABC_1” 
and “ABC_raw” will be included in the group ABC. If not checked, spectra that do not match the exact name 
in the file will be discarded. 

Top tip! Sometimes the Mapping file can be used to generate final reports with input and output data. In 

these cases, a configuration of the columns reserved for output can be set in the plugin-specific settings dialog.   
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3.1.5. Experiment detection modes 

Detection of the experiment files to be used for the analysis can be achieved either automatically or manually. 

This can be selected at the top left-hand side of the Input tab when data files are retrieved from Disk or in 

Real Time. 

In the Automatic detection mode, experiment files will be automatically recognized by the system.  

 

Given that Mgears can support various types of analyses (NMR (1H, 13C, 19F, HSQC…), LC/GC/MS, 

chromatography, UV/IR/Raman/Fluorescence) as well as any Mnova documents, it is possible to select the 

type of data files you wish to analyze, and restrict detection by Mgears to those. 

To do so, click on Experiment Selection. A new section with all available experiment types will appear on your 

screen. Check the boxes of the experiments of interest. 

 

 

Watch out! You may need to configure the file masks to ensure the correct automatic detection of 
experiment files.  
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In the Manual detection mode, a Path Mask must be provided to define the experiments that should be 

considered in the analysis. All Operating System standard conventions apply (*, ?, !, etc.). 

To do so, enter the Path mask for the experiments of interest. Use the Inspection option  to inspect the 

detected files. 
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3.2. Processing  

The processing tab allows you customize data processing: 

□ Solvent: Tick this option to replace the default solvent with another one by simply typing your new 

solvent name.  

 

□ Blind regions: can be added to NMR or LC/GC-MS spectra. You can either: 

•  Manually add blind regions 

•  Import a “blind regions” file  

 

Click on  or  to Delete a row or Clear the whole table, respectively. 

□ Processing Templates: To add templates, click on , specify the type of spectra this template should 

apply to, then add the template path.  

 



Mnova Gears 2.5 | User Manual                                                                                                                      

P/N 236 R3          Page 31 of 75 

Your added template will be displayed in the table as seen below: 

 

You can add one more template and each will be applied to the corresponding spectra. When 

simultaneously applying a template for COSY and another for 2D, then the most specific template (in 

this case the COSY template) will be applied to the COSY spectra, whilst the 2D template will be applied 

to the 2D spectra in your analysis. 

Click on  or  to Delete a row or Clear the whole table, respectively. 

□ Apply NMR Advised Processing: If you enable this feature, the best processing options will be 

automatically applied to the data in hand. This includes automatic referencing by solvent and linear 

prediction for your spectra. You can check/uncheck the type of processing you want to apply in the 

advised processing setting dialog. 
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□ Script: Various custom Mnova scripts can be applied for processing. You can run a single script at the 

beginning of automation (Starting script), a separate script for each sample (Processing script), and a 

third script to automatically rename groups assigned by Mgears (Script for renaming groups). Click on 

 and upload a script to use. Below is an example of a processing script that will run a multiplet 

analysis on each spectrum of a document: 

 

 

In this other example, we will use a script to rename input data groups. The script used will add “_new 

extension” to our data groups. 

 

After running the Mgears analysis, data files will be renamed as indicated in the script. 
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3.3. Plugins  

The plugins tab is where you select and configure the analysis plugins you want to run. To include a brick in 

your workflow, select it and click the Add button.  

 

 

You can add one or multiple plugins to run one after the other on the same dataset. The plugins are displayed 

in the order they will be executed. 
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A number of plugins are available with Mgears 2.5: 

Plugin Technique Analysis 

SQA NMR Spectral quality assessment 

Verify 
NMR, 
LC/GC-MS 

Automatic structure verification on NMR and LC/GC-MS data 

Purity NMR Purity determination by quantitative NMR analysis 

Concentration NMR Concentration determination by quantitative NMR analysis 

Peak Report NMR Automated peak reporting 

Multiplet 
Report 

NMR 
Automated multiplet reporting 

MPublish NMR Automated preparation of supporting information for publications 

IUPAC Name NMR Automated and batch IUPAC naming of molecular structures 

DB Search NMR Automated search of spectral data in one or more databases 

SMA NMR Targeted mixture analyses by NMR for batch and real time workflows 

MANIQ NMR Automated identification and quantification of compounds in a mixture 

QC profiling LC/GC-MS Purity assessment of DNA encoded library compounds 

MS Scan 
LC/GC-MS Automated extraction of mass spectra and mass chromatograms for total ion 

chromatograms 

Chrom Reaction 
Optimization 

LC/GC-MS 
Automated analysis to determine the optimal chemical reaction conditions 

Chrom Cal 
LC/GC-MS Automated evaluation and generation of calibration curves for many compounds at 

the same time 

Affinity Screen 
LC/GC-MS Automated solution for affinity selection mass spectrometry data processing, 

interpretation, and hit identification 

Fraction 
Analysis 

LC/GC-MS 
Automated evaluation of fractions collected with preparative chromatography  

Chrom Best 
Method 

LC/GC-MS Automatic scoring tool for selection of chromatographic methods with optimal 
separation conditions 

Each brick has its own settings that can be configured in just a few clicks (details about plugin configuration 

are provided in a separate starting guide for each application).  

To open the plugin-specific settings, select the plugin and then click on the settings button, or simply double-

click on the plugin.  

 

https://mestrelab.com/software/mnova-gears-sqa/
https://mestrelab.com/software/mnova-gears-verify/
https://mestrelab.com/software/mnova-gears-purity/
https://mestrelab.com/software/mnova-gears-concentration/
https://mestrelab.com/software/mnova-gears-peak-report/
https://mestrelab.com/software/mnova-gears-multiplet-report/
https://mestrelab.com/software/mnova-gears-multiplet-report/
https://mestrelab.com/software/mnova-gears-mpublish/
https://mestrelab.com/software/mnova-gears-iupac-name/
https://mestrelab.com/software/mnova-gears-db-search/
https://mestrelab.com/software/mnova-gears-mixtures-analysis-sma/
https://mestrelab.com/software/mnova-gears-maniq/
https://mestrelab.com/software/mnova-gears/gears-qc-profiling/
https://mestrelab.com/software/mnova-gears-ms-scan/
https://mestrelab.com/software/mnova-gears-chrom-reaction-optimization/
https://mestrelab.com/software/mnova-gears-chrom-reaction-optimization/
https://mestrelab.com/software/mnova-gears-chrom-cal/
https://mestrelab.com/software/mnova-gears-affinity-screen/
https://mestrelab.com/software/mnova-gears-fraction-analysis/
https://mestrelab.com/software/mnova-gears-fraction-analysis/
https://mestrelab.com/software/mnova-gears-chrom-best-method/
https://mestrelab.com/software/mnova-gears-chrom-best-method/
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The workflow configuration can be easily saved and shared by clicking on Save Settings . A “.data” file will 

be generated with the saved settings and can be quickly loaded in the future or on another computer with 

Mgears, by clicking on Load Settings . 

If the analysis you want to perform is not covered by our plugins, it is possible to create a custom plugin by 

uploading your own script. To do so, click on the New Custom Plugin icon, Name your plugin, then upload the 

Analysis Script (which could be developed outside the automation on individual samples). Then, choose the 

Reporting preferences (optionally also using your own reporting script), and click on OK.  

 

The new custom plugin will appear in the list of available plugins. You can delete a previously added custom 

plugin by selecting it and clicking on Delete Custom plugin. 
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3.4. Design  

In the design tab, Mnova layout templates can be applied to the output documents resulting from the analysis 

performed. You can easily create your own template with Mnova, laying out the pages as per your requirement 

and including any custom graphics or images, then save that document as a template that can be used with 

Mgears. 

 

Click on  and select the template file you want to apply. You can check the Apply Layout Template to All 

Pages option to apply the layout on every page of the output document. 

 

A Script can also be applied to achieve highly complex layout needs.  
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If you have different templates to be applied for different types of analyses, then you can expand the 

Advanced design section and click on  to add your different templates. A dialog will open to allow you to 

choose the analysis type. You can then select the template path from the directory. 

 

Your added templates will be displayed in the table as seen below. You can click on    to delete a previously 

added template, or on  to clear the entire table. 

 

When different templates can be applied to the same dataset, the most specific one will be used.  For instance, 

if a template for COSY and another for 2D spectra are added, then the COSY template will be applied to COSY 

spectra.  
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3.5. Output  

The output tab is where options for saving reports are configured. There are two main options: saving data in 

Disk directories and saving data in a Database. In addition, several advanced switches allow you to customize 

how the output is saved. 

3.5.1. Saving output on Disk 

To save output data on disk, click on  and choose a directory in which to save your analysis results. 

 

The result folder is by default named according to the date and time of your analysis, e.g., 2021-01-

08T08.06.58. However, it is possible to either add a nickname to the result folder name or completely replace 

the result folder default name with a nickname of your choice.  

Enable the Add Nickname to the Results Folder option and type the desired nickname. 

 

Enable the Only Nickname option to remove the timestamp from the folder name and only use the indicated 

nickname. 

 

Enable the Add Incremental Numbering option to add a number to the folder’s name when another folder 

with the same nickname is detected in the output directory.  
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If your input data is organized within sub-folders and you want to analyze them individually, you can enable 

the Sort in Subfolders option. Enabling this option will prompt the system to detect and separate the data 

within each subfolder. A distinct report will be generated for each subfolder. See below an example with an 

HTML report for each subfolder. 

 

When you activate the Sort in Subfolders option, you can also utilize the Split Results in Subfolders feature. 

Enabling this option allows you to save the Mnova and PDF outputs in subfolders named after the 

corresponding input subfolders. 
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Both an interactive Mnova file and a human readable PDF can be generated and saved along with your analysis 

results.  

3.5.1.1. Saving an Mnova document 

Check the Mnova options and configure the saving settings as needed: 

• The Mnova document is saved by default in the output folder in a sub-folder named “documents”. 

 
 

• You can save the Mnova document in the folder of your choice by ticking the option Save Mnova 

Document in and selecting the desired destination folder. 

 
 

• You can also Save a copy of the Mnova document with the input data by ticking the corresponding 

option. 
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3.5.1.2. Saving a PDF document 

Check the PDF options and configure the saving settings as needed: 

• You can save the PDF document in the Results folder (configured above as the Directory). It will be 

saved in a sub-folder named ‘pdf’. 

 

 

• The PDF can also be saved along with the input raw data. 

 

 

• The PDF can alternatively be saved in a separate folder by ticking the Save PDF in option and 

selecting the desired destination folder. 
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• You can Protect PDF from Editing by enabling the corresponding option: 

 

 

• You can also Add Analysis type in the Name of the PDF; 
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• or Embed PDF in Mnova document. 

 

 

• When results are saved to a database, it is also possible to Save PDF in a New record. If this option is 

unchecked, the PDF will be saved in the record along with the processed data.  
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3.5.2. Saving output in a Database 

Mgears results can be saved to an Mnova spectral database. To do so, you will need to check the DB option, 

indicate your Server address, Port, and your credentials (User and Password), then click on Connect. 

 

Once connected to the server, you can select the database you want to save the results to. 

 

Check the Update Existing Record option if you want Mgears to search for and attempt to update an existing 
record in the DB before saving your results to a new one: 

• When the input comes from Disk directories, Mgears will search for the name 

of the experiment in the DB. If the ID is found in one record, it will be updated, 

otherwise a new record will be created. If the ID is detected in more than one 

record, the log will show an error, and nothing will be saved to the DB. 

• When the input comes from the DB, it will update the registry associated with 

the input. 

Watch out! This feature will only work with DBs created with Mnova 14.0.0 or higher, and the Mnova DB 

Server version 1.8.3 or higher (with a field custom ID on each item). 

3.5.3. Saving output in an ELN 

Mgears can detect your ELN plugin and save the analysis output directly to it. Contact us for assistance. 

3.5.4. Expert settings 

Additional settings can be configured for analysis output under the Expert section: 

□ An Output Script that gives complete control over the output generation and saving can be used, for 

example, to send details of the report to a web service and update an external database, or to write 

results in a custom data folder structure, etc. Click on  to select your Output Script.  

 

mailto:support@mestrelab.com?subject=Arxspan%20ELN%20connector%20for%20Mnova%20Gears
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□ A Summary Script that runs at the end of a batch analysis (in disk or DB modes) to evaluate all the 

results of the different bricks together and provide a global result (e.g. statistical estimators for all the 

results). Click on  to select your Summary Script. of running a Summary script to  

 

□ Zip and Save Raw Data: If checked, Mgears will create a zip file with the raw data from the processed 

directory and save it in the output folder. 
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□ Zip and Attach Raw Data: If checked, Mgears will create a zip file with the raw data from the processed 

directory and embed it in the resulting Mnova document. 

 

□ Attach Data from Input Folders: Enable this feature if you want to attach all Zip and PDF files from 

each processed input directory to the Mnova document. 
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□ Save Structure in a New Record: This option is available when output is saved into a database. If 

checked, the structure will be saved in a new separate record, otherwise it will be saved together with 

the processed spectra. 

□ Avoid Saving Images: You can enable this option to avoid saving images of the molecules and spectra  

in the output folder. Images will not be displayed in the html report either. 

□ Create Reports on-the-fly: If this option is checked, Mgears will create all reports after processing 

each experiment instead of waiting until the end of the whole task. 

□ Save Results in Subfolders Sorting by Parameter: With this option enabled, it is possible to distribute 

the results into different folders according to any of the available spectral parameters. Open an input 

spectrum by clicking on Open Parameters. Mgears will read the available parameters in your input 

data and list them so you can select one to sort your results. Click on OK. 
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3.6. The Settings tab 

The settings tab does not form part of Mgears workflow but allows the specification of various aspects of 

automation, and the configuration of the Notifications system for receiving automatic emails related to your 

Mgears analyses. 

3.6.1. General settings 

The general settings include the following: 

□ Verbose log: Check this option to include detailed information in the log. 

□ Autoload Results in the Viewer when Finished: If enabled, the Mgears Result Viewer will 
automatically load the results of a batch analysis once completed.  

□ Autoload Results in the Viewer on-the-fly: If enabled, the Mgears Result Viewer will automatically 
load the results in real time, as soon as they are obtained. 

□ Copy Files Only: If enabled, Mgears will exclusively copy data to the output folder without opening, 
processing, or analyzing it. This option hides processing and analysis related tabs and options and is 
functional only with automatic data detection in Batch and Real-time modes. 

 

3.6.2. Expert settings 

More settings options are included in the Expert section: 

□ Debug Mode (Execute all processes in Foreground): If enabled, the log will contain information about 
the internal state of the objects inside Mgears. This option is mainly used for debugging and 
development purposes. 
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□ Debug Log: If checked, the Mgears log file will give information about Mgears, the available plugins, 
and the current analysis, and will be saved in the results folder. 

 

□ Auto Attach traces: Check this option to automatically attach 1D spectra as horizontal and vertical 
traces in 2D spectra. With this option selected, the HSQC with the 1H spectrum can be correctly added 
as the horizontal trace in an HSQC spectrum. 

 

□ Allow events: If checked, Mgears will not block programmed events (Preferences > Scripting > Events). 

□ Autoresume on Critical Error (Not available in Debug Mode): When enabled, Mgears will resume 
analysis automatically should a critical error occur. 

□ Retry on Error Opening Dataset: Check this option if you want to force Mgears to retry opening a file 
after an error occurs (Errors can occur if the file is not in the expected location, or the opening 

operation fails). Click on the Retry Settings icon  to set the number of retries and the time the 
system must wait between each. 
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□ CSV Separator: Select the CSV separator used in your csv input file in order to be read correctly by 
Mgears. 

 

3.6.3. Notifications 

Mgears can send automatic email notifications to users to inform them about processing status. To set up 

email notifications, tick the Notifications option and fill in the required information. 

In the Setup tab, configure the email server from which the email will be sent by completing the information 

about your email server (Server, Port, Username, Password, etc). 
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Once all fields are configured, you can test the notification by adding a Test Address and clicking on Test. 

 

In the Receivers section, you can either add a Fixed List of Receivers or get the recipients’ emails from a 

Parameter in your spectrum. 

 

In the Content tab, write the notification Subject and Body text. You can use “$NAME$”, “$NMR(Parameter 

name)$”, “$MS(Operator)$”, etc., to get analysis-specific information in the subject line and body text. For 

instance, if you use $NAME$, the name of the dataset in hand will be used, whilst if you use $NMR (parameter 

name)$, the actual value of the parameter will be displayed.  

The Body text field also admits HTML formatting. 
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Finally, in the Options tab, choose if you want notifications to be sent when a dataset is processed and/or 

when an error occurs, and choose if you want to attach an Mnova and/or PDF document to the notification. 

 

Top Tip! All of the configuration settings entered in the various Mgears tabs can be saved and recalled in 

the future. This is particularly useful when you run many different analyses, as it allows a consistent and quick 

setup when switching between tasks. The Settings files so created (.mgrs) can therefore be thought of as the 

way to save a complete automation setup.  

 

This file can also be used to set up the MyGears workflows, as discussed below.  
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4. MyGears dialog 

MyGears’ workflow setup is very similar to Mgears´, the main difference being that MyGears will run the 

automated analysis on a single dataset open in Mnova, and therefore there is no need to configure the Input 

tab. 

To create a MyGears workflow from scratch, open the Mgears dialog from the Automation section in the 

Mnova ribbon and proceed as described in sections 3.2, 3.3, 3.4, 3.5, and 3.6 to configure the Processing, 

Plugins, Design, Output, and Settings of your analysis. Then, save the settings to a directory of your choice. 

To run a MyGears analysis, first open your dataset in Mnova, then open the MyGears Workflows from the 

Automation section in Mnova. A dialog with the following buttons opens: 

 

  



Mnova Gears 2.5 | User Manual                                                                                                                      

P/N 236 R3          Page 54 of 75 

Click on  and select the Mgears workflow (.mgrs settings file) you want to run. You can add one or more 

workflows, delete  a selected workflow, or clear  the whole table as needed. The workflows added will 

be displayed as shown below.  

 

Click on this button  to launch the analysis. The data in the open document will be processed and the results 

laid out and saved as specified in the workflow parameters. 

If you wish to review the analysis settings before launching the analysis, you can select the workflow you want 

to review and click on . A dialog asking if you want to load the settings of the selected plugin will appear. 

Click Yes. 
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The Mnova Gears dialog will open so you can revise and adjust your analysis configuration as needed, then 

save the new settings. 

 

Note. It is also possible to run a MyGears workflow by pressing the MyGears button in the Automation tab. 

In this case, MyGears will run with the configuration stored in the registry. 
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5. Output folder 

The result folder is saved under the directory previously specified in the Output section. This folder contains 

all the output generated for the current evaluation. 

 

Output folders and files may include: 
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Plugin-specific results files (.csv, .odt, .mnova files, etc) are generally customizable in the Plugin Settings 

section. For instance, the IUPAC Name plugin can be configured to generate SDF files for each molecule, and 

MS Scan to lay out results in a CSV document; HTML reports can be set to include specific parameters and 

exclude others with Purity; and Peak Reports can be formatted as needed, etc. 
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5.1. Mnova Reports 

Mnova output files are typically saved under Documents. However, it is possible to change the desired 

destination folder during the setup in the Output tab, as explained in the section 3.5.1.1. Other advanced 

reporting settings are detailed in section 3.5.4. 

Mnova reports can be customized to fit a display layout of your choice in the Design tab (Section 3.4), and to 

include the specific information (data, metadata, results, etc.) selected in the Plugin settings, as shown below. 

 

Here is an example of an Mnova report obtained with the Purity plugin. 
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5.2. PDF Reports 

PDF reports are typically saved under the PDF folder. However, it is possible to change the desired destination 

folder during the setup in the Output tab as explained in the section 3.5.1.2. Other advanced reporting settings 

are detailed in section 3.5.4. 

As with the Mnova reports, PDF reports can be customized to fit a display layout of your choice in the Design 

tab (Section 3.4), and to include the specific information (data, metadata, results, etc.) selected in the Plugin 

settings. PDFs are basically a static version of the Mnova reports generated by Mgears. 

Below is an example of a PDF report obtained using the Purity plugin. 
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5.3. CSV Reports 

Many Mnova Gears Plugins will generate a CSV file with their results. The content of this CSV file is usually 

customizable in the Plugin specific settings, as with the MS Scan plugin. 

 

Sometimes the Mapping file used in the Input tab can be used to generate final reports including input and 

output data. In these cases, a configuration of the columns reserved for outputs is possible in the plugin-

specific settings dialog, as shown below for the Chrom Reaction Optimization plugin. 
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5.4. HTML Reports 

HTML reports are commonly generated by Mgears analyses. These global reports include the analysis 

parameters and allow a dynamic visualization of the analysis results. Direct links to other output files are also 

embedded in these reports. 

 

In some cases, HTML reports can include graphics to better represent the results. 
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It is possible to change the display of the Columns and adapt them to your preferences, then Copy, Print, or 
save your results into CSV or PDF format. 

 

6. Mnova Gears Results Viewer  

One of the most interesting features of Mnova Gears is its results viewer, which allows live interaction, 

reviewing, and rapid update of analysis results once an Mgears analysis has been completed. 

The Mgears Viewer is accessible from the Mnova Automation section. When open, the dialog presents several 

action buttons described in the table below.  
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6.1. Loading results 

To load analysis results, click on the load button  and select the data folder in the predefined output 

location. Alternatively, click the small arrow next to the Load button to see a list of the 10 most recent results 

for easy access. 

 

All samples processed in the selected analysis are loaded into the Mgears viewer’s main list and well plate 

overview. Detailed results are visible at the bottom section.  

When the viewer is connected to a folder , the results saved to that folder are automatically loaded (on-

the-fly) once the analysis is completed. 

Note that the Mgears viewer shows the results of one automation run at a time. When using MyGears, it will 

show the latest results. 
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6.1.1. Main list section 

In the upper part of the Mgears Viewer, analysis samples are listed and numbered with certain details such as 

Title, Document, and Location. It is possible to change the configuration of this table. To do so, click on the 

Settings button  and customize the Main List visualization by checking/unchecking the available items. 

 

The Main list can be completely hidden from the Mgears Viewer by clicking on this button . 
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6.1.2. Well plate section 

A Well Plate overview is available and can be particularly useful when analysis samples are loaded in a well 

plate. The dimensions of the well plate can be defined in the Mgears Viewer Settings dialog. 

 

Watch out! If a Mapping file is used in an analysis, and the option for reading position in the well plate is 

selected in the advanced filtering options, then the dimensions of the well plate will be automatically set and 

will not be editable in the Mgears Viewer Settings dialog. 

 

An option to Draw Well Plate with Enhanced Graphics is available in the Mgears Viewer Settings too. This 

feature allows you to choose between displaying Bubble plots or a Heat Map within the well plate, instead of 

presenting numerical results. The Text font and size can be customized. See the example below. 
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To add a suffix to the results that are displayed in the well plate, enable Add Suffix to Values in the Well Plate 

and type your desired suffix. 

 

The Well plate overview can be completely hidden from the Mgears Viewer by clicking on this button . 
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6.1.3. Results section 

In the Results section, detailed analysis results are displayed.  

 

If the analysis performed generates multiple results per sample, the Mgears viewer provides flexibility to 

display those results. 
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Also, when running multiple analyses (plugins) on the same samples, multiple results tabs will be available to 

view all the associated results. 

 

 

The Results section can also be completely hidden from the Mgears Viewer by clicking on this button . 
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6.2. Reviewing results 

Reviewing analysis results is available for most plugins and can be done on a sample-by-sample basis. Click on 

a sample (table row or well from the plate overview) to load the corresponding Mnova result document and 

detailed results. 

 

You can review and edit your results using the standard tools from Mnova. 

6.2.1. Changing analysis settings 

Mgears allows you to modify your current settings and re-run calculations on your data. Depending on what 

you wish to modify you can either: 

a. Click the brick  icon in the top bar of the Mgears Viewer. This opens the Mgears dialog with the 

current settings. The Input, Processing, Output, and Setting tabs are not editable, but you can make 

changes in the Design and Plugins tab. After making desired adjustments, click Update, and then 

Analyze Again to relaunch the analysis with the updated settings. 

 

Note. To access these Mgears settings from the Mgears Viewer, make sure to enable the option Show 

Button to Open Setting in Mgears in the Mgears Viewer Settings . Without this option enabled, 

the brick icon won't appear in the top bar of the Mgears viewer. 
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b. For some bricks, you can access specific settings directly by clicking the brick  icon in the Results 

section of the Mgears Viewer. This provides access to brick-specific settings, bypassing the Mgears 

tabs. 
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6.2.2. Result reviewing tools 

In the Results section, you will discover a range of tools to enhance and update your analysis results. These 

tools may include manual peak assignment, adding comments, overriding results, and more. The specific 

options available depend on the Mgears brick in use. See some examples in the image below. 

 

6.2.3. Advanced result reviewing with Mnova plugins 

An advanced review of the sample results can sometimes be achieved with the Mnova Standard plugins, as is 

the case with Purity and SMA, for example.  

In the example below, an open Mgears results document is loaded into the Mnova Purity dialog: 

1- Click on sample to view results in Mgears viewer. 

2- Open Purity plugin in the Mnova Quantitation ribbon. 

3- Then, click on  to load the Purity results from the open Mnova document.  

4- Sample and reference details, as well as all spectral multiplets, are loaded in the Purity dialog. 

5- Revise and edit sample results. 

6- Edited results will be automatically updated in the Mgears Viewer and Mnova document.  
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6.3. Saving results 

When revising your results, you may want to reanalyze your dataset with the changes you made. To do so, 

click on the Analyze Again button at the top-right side of the Mgears Viewer. The analysis results will be 

automatically updated in the open document, as seen in the example below for the Multiplet report plugin. 

 

If you wish to reanalyze the whole batch, click on the little arrow next the the Analyze Again button and choose 

Analyse Again All Results. Mgears will recalculate and update the results for the whole well plate.  

 

If you are happy with these new results, you can click on  to save them to the output folder.  
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Top Tip! Enable the option Save Automatically upon Clicking Analyze Again in the Mgears Viewer Settings. 

The results will then be automatically saved to the output folder without the need to hit Save every time you 

reanalyze a sample. 

 

 

7. Scripting and customization 

Mgears provides options for customization using scripts at various points in the process, as seen throughout 

this User Manual. For example: 

• On the input tab, a custom script can be provided to read a structured input file (a csv or xml) from 

another system and use it to drive Mgears input, or to retrieve an identifier from within a parameter 

file and use that for grouping. It is even possible to change the whole algorithm of detection in batch 

mode. 

• A processing script can be invoked on the processing tab, where there is even the possibility of being 

able to run a ‘pre’-script before individual file processing starts.  

• A custom design script can be used to meet complex layout requirements that would not otherwise 

be easily achieved in a template. 

• A custom script can also be used to create a new plugin for running your own analyses. 

• Finally, a custom output script and/or a summary scipt can be used to allow a highly complex and 

specific output to be generated, as is sometimes required by some downstream system in the 

workflow.  

The possibilities are only limited by programming ingenuity. 

You can create and save your own scripts in the Script Editor accessible form the Tools section in Mnova.  
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An Mnova scripting document is available to help you with Mnova’s extensions. Click on  to access this 

documentation. 

 

8. Conclusion 

Mnova Gears provides a robust platform for automation of workflows, and limitless possibilities for 

customization. Please contact us with your inquiries at info@mestrelab.com and let us help to set up your 

powerful automation system. 

mailto:info@mestrelab.com
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